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1 INTRODUCTION 

Introduction goes here 

 

2 AIMS AND OBJECTIVES 

1. Aim One. 

2. Aim Two. 
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3 REVIEW OF LITERATURE 

3.1 HEADER TITLE STYLE 2 

3.1.1 HEADER TITLE STYLE 3 

3.1.1.1 HEADER TITLE STYLE 4 

3.2 HEADER TITLE STYLE 5 

3.2.1.1.1.1 Header title style 6 

3.2.1.1.1.1.1  HEADER T ITLE SYTLE 7 

 

3.3 SECTION BREAKS!!!! 

This template has most of the formatting done for you. However, as you add your 

content, there are some things you should be aware of. First, in the Insert menu, there 

is an option break… This was used in this template to insert section break-next page 

between chapters in order for footnote numbering to restart. This is also how page 

numbering has restarted from the introduction page (roman numerals were used in the 

previous section containing table of contents, acknowledgement etc.)   

3.4 ADDING A FIGURE 

To add a figure, in this case a clipart duck, use the insert menu to add a picture. After it 

is inserted, right click on the image and choose Format Picture… In the Layout tab, 

choose In line with text. Next, center the image with the center button on the tool bar. 

Finally, right click on the image again and choose Caption… You should choose Label: 
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Figure and Position: Below selected item. In the top text area, type in a colon (:) and 

the information that you want to appear as a caption. The word Figure will be added 

automatically. At the top of the next page, you should see a well-formatted 

demonstration duck complete with caption. 

 

Figure 1: Demonstration Duck. Frequently used by dissertation & thesis template 

authors to demonstrate appropriate line spacing for figure captions. 

This figure is centered between margins. However, the left margin is 1.5 inches and the 

right margin is only 1 inch, so the figure appears offset somewhat. Note the single 

spaced caption. 

3.5 ADDING A TABLE 

Adding a table in portrait page orientation is not difficult. To add a caption, highlight 

the entire table, right click and choose Caption…as you would with a figure. However, 

for tables, you should choose Label: Table and Position: Above selected item.  

Table 1: Loka  and Terno. Note that this very long caption is single spaced both in 

the text and in the list of tables. 

 North East South Central West 

Loka 11234 3342 2345 2345 15643 

Lingva $35K $37K $39K $33K $37K 

Auart 35-45 32-41 33-39 22-33 35-40 

Tereno 33% 22% 90% 44% 2% 
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3.6 UPDATING YOUR TOC AND LISTS OF FIGURES AND 

TABLES 

To update the table of contents, the list of figures or the list of tables (they are found 

back in the roman numeral pages,) go back to that TOC or list and right click on it. 

Choose Update field and then Update entire table. All page number references are 

inserted and/or updated automatically.  Do this every time you open the document. 

Frequently (and especially for long documents) the TOC will “grab” page numbers 

before the whole document is loaded, which results in a wacky TOC.  

Ed te dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero 

odolum dolorem ing enisim1 eumsandiam ilis nullamc onullut dolore tie dolorem quat.  

Rit inim aliquisi tet, quam zzrit illanortisi. Ed te dignibh ea faccum ipsustrud dolor alit 

augue dolore veliquiscin euguero corpero odolum dolorem ing enisim2 eumsandiam ilis 

nullamc onullut dolore tie dolorem quat.  Rit inim aliquisi tet, quam zzrit illanortisi. 

Duis non arcu vitae dolor porttitor commodo. Aenean malesuada augue a 

risus. Donec nisl. Nulla facilisi. Vestibulum ante ipsum primis in faucibus 

orci luctus et ultrices posuere cubilia Curae; Curabitur tristique nunc eu 

pede. Ut felis velit, aliquam id, luctus sit amet, laoreet vitae, lorem. 

Suspendisse potenti. Donec eu diam viverra mi imperdiet rutrum. In laoreet 

scelerisque enim. Donec blandit sapien vel est.3 

 
1 Rit inim ibid a lot. 
2 Rit inim ibid a lot. 
3 Aybabtu 1723, nullarfarm tricky, corpero odolum dolorem ing enisim3 eumsandiam ilis nullamc onullut 

dolore tie dolorem quat.  Rit inim aliquisi tet, quam zzrit illanortisi. Ed te dignibh ea faccum ipsustrud 

dolor alit augue dolore veliquiscin euguero corpero odolum dolorem ing enisim 3  eumsandiam ilis 

nullamc onullut dolore tie dolorem quat.  Rit inim aliquisi tet, quam zzrit illanortisi. corpero odolum 

dolorem ing enisim3 eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit inim aliquisi tet, quam 

zzrit illanortisi. Ed te dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero 

odolum dolorem ing enisim3 eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit inim aliquisi 

tet, quam zzrit illanortisi. corpero odolum dolorem ing enisim3 eumsandiam ilis nullamc onullut dolore 

tie dolorem quat.  Rit inim aliquisi tet, quam zzrit illanortisi. Ed te dignibh ea faccum ipsustrud dolor alit 

augue dolore veliquiscin euguero corpero odolum dolorem ing enisim3 eumsandiam ilis nullamc onullut 

dolore tie dolorem quat.  Rit inim aliquisi tet, quam zzrit illanortisi. corpero odolum dolorem ing enisim3 

eumsandiam ilis nullamc onullut dolore tie dolorem que. This is a very long footnote to show what long 

footnotes do when they overflow the the next page. For more interesting reading, try the demonstration 
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3.7 ADDING A TABLE IN LANDSCAPE ORIENTATION 

Adding a table, figure or other content in landscape orientation is a little more tricky, 

as your page number must still appear as if you are in portrait orientation. To do this, 

you must insert two section break- next page (which is not just a page break, be careful 

that you get the one under section break types!) Go to the view menu and change to 

normal if you are not there already. You should see two double lines labeled Section 

Break (Next Page). Place your cursor between these section breaks and go to the file 

menu and choose Page Setup…  You should chose landscape orientation, and make 

sure that your margins are as follows: top 1.5 inches, other sides 1inch. Also, be sure 

that you have chosen Apply to This section or you will make the rest of (or maybe all) 

your document landscape oriented.  

The next part, dealing with page numbers, can be difficult depending on the version of 

Word that you are using. This template was developed in MS Word 2003; there is 

documentation available for other versions of Word online. If these steps don’t work, 

you can find alternate workarounds by searching for “adding portrait numbers to 

landscape pages.”  

To make the numbering scheme work, first go to the View menu and choose Header 

and Footer. Place your cursor in the footer of the first page to have landscape 

 
duck caption in section 1.3. At illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, 

quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit 

illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim 

aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam 

zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit 

inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, 

quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit 

illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Rit inim aliquisi tet, quam zzrit illanortisi. Ed te 

dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero odolum dolorem ing 

enisim3 eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit inim aliquisi tet, quam zzrit 

illanortisi. 
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orientation and, and on the Header and Footer menu that appeared when you went to 

that view, press the Link to Previous button. The go to the footer of the first page that 

is back in portrait orientation and do the same thing. This button toggles a header or 

footer’s connection to the previous pages setup. You want to BREAK this connection 

before and after the landscape page so that you can move and reorient the landscape 

page formatting without affecting other pages.  

After this is done, you can click on the page number of the landscape page and drag it 

to the left side of the page, which will be the bottom once it is stacked with other portrait 

pages. To orient the page number in the correct direction: while the page number box 

is still selected, go to the Format menu and choose Text Direction. Choose the option 

that orients the bottom of the page number to the left side of the page.  

The final step is to confirm that your landscape page number is aligned with portrait 

page numbers. To do this, print one portrait page and your landscape page, stack them 

as if they were bound and hold them up to a light. You can see then how to adjust your 

landscape page number box.  

You can add a caption to your content just as you would in portrait view. This is shown 

on the next page… 



 

 

7
 

 

 

 

Figure 2: Graph  
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Ed te dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero 

odolum dolorem ing enisim eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit 

inim aliquisi tet, quam zzrit illanortisi. 

 

Ed te dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero 

odolum dolorem ing enisim eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit 

inim aliquisi tet, quam zzrit illanortisi. 

Table 2: Animal Damage 

 Duck Beaver Donkey 

Cost 3342 11234 2345 

Damage 33% 90% 22% 

 

Ed te dignibh ea faccum ipsustrud dolor alit augue dolore veliquiscin euguero corpero 

odolum dolorem ing enisim eumsandiam ilis nullamc onullut dolore tie dolorem quat.  Rit 

inim aliquisi tet, quam zzrit illanortisi. 
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3.8 WHAT WILL HELP YOU WITH YOUR FORMAT 

CHECK? 

We have added a note about common errors that you should avoid. Be sure to do this—

lest your draft be flagged and your life ensnarled in correcting mechanical issues like 

this (instead of making the substantive changes your advisor suggests so that you can 

move on with your life.) Read more in the next section after briefly admiring the 

demonstration donkey, below. 

 

Figure 3: Demonstration Donkey 

Aenean congue rutrum velit. Nam bibendum elit faucibus nisi. Fusce interdum aliquet 

elit. Nunc malesuada quam sed augue. 

3.9 AVOID THESE COMMON MISTAKES! 

1. The title on both title page and abstract title page needs to be in headline 

capitalization/title case : capitalize every word except articles (“a,” “an,” and “the”); 

coordinating conjunctions (for example, “and,” “or,” “so,” “yet,” and “nor”); and 

prepositions with fewer than four letters (like “in”). The first and last words are always 

capitalized, regardless of what they are. The title should be entered exactly as you want 

it to appear on the final dissertation. Example: “Sampling and Signal Estimation in 

Computational Optical Sensors”. 
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2. Paragraph at the bottom of the Abstract page should begin, “An abstract of a 

dissertation . . .” or “An abstract of a thesis…..” The word “Abstract” should appear 

at the top of the page. 

3. All pages must be numbered except for title pages and copyright page. Preliminary 

pages are numbered with lower case Roman numerals. The “Introduction” or “Chapter 

1” page numbering should begin with Arabic number “1”. 

4. Individual chapters should begin with a new page (but with continuous numbering 

from previous chapter). 

5. Footnotes should begin re-numbering with “1” at the beginning of each new chapter. 

6. On landscape oriented pages (Figures and Tables), the page number must be 

centered on the bottom of the page with at least a 1” margin beneath. (must appear as 

if it was on a portrait page) 

7. When an entry in the Table of Contents, List of Tables, or List of Figures, is longer 

than one line, the entry should be single spaced within and double spaced between 

entries. 

8. Chapter/Section titles that are longer than one line should be single spaced within. 

9. A long quotation should be indented four spaces and single spaced. 

10. List the Abstract, Bibliography, the Biography in the Table of Contents. 

11. Maintain a 1.5” left-hand margin and 1” for top, bottom, and right-hand margins. 

3.9.1 FORMATTING THAT YOU CAN CHANGE 

 Not everything in this template is a requirement. You can, for example, not use 

the section numbering scheme (2.1.1, etc.)   
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4 SUBJECTS AND METHODS 

This was a prospective observational study, which was conducted at the Mahatma 

Gandhi Medical College and Research Institute Hospital, a rural tertiary care hospital 

with an annual volume of above 1,00,000 patients over one year period.  

The Institutional Medical Ethics Committee approved this study. From January 2010 

until April 2011 we enrolled children between the ages of 1 month and 6 years of age 

who were referred primarily from xxy and xxz departments for so and so condition to 

participate in this study. Written informed consent was obtained from the Parents (and 

assent from the children) and an xxz examination was done immediately.  

We excluded all patients with .. insert exclusion criteria or write it separately under a 

subheading. 

4.1 BRIEF EXPLANATION OF THE PROCEDURE 

 Ipsum doler loasdf. Asdlk;jfas a;sdlfkjasd;flkjasdofiawel asdl;fkj asl;dfkja 

sdl;fkjasdfljas;  

4.2 TECHNIQUE AND PROTOCOL IN SOP STYLE 

Instruments used,  

For the purpose of standardisation, 

. 

4.2.1.1.1 STANDARD OPERATING PROCEDURES – SUB PROCEDURE 

The young subject in close proximity of accompanying parent, on entering the 

Ultrasound room is allowed to acclimatise to the darker ambience and given ample 

time to feel at ease. He or she is introduced to the Investigator and briefed about the 

procedure about to be undertaken.  
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erformance feedback from the Investigator.  

4.2.2 IMAGING TECHNIQUE SOP 

 

4.3 POTENTIAL PITFALLS AND NOTES: 

4.3.1 SOME PROMINENT ISSUE: 

 

4.4 DATA COLLECTION 

All data was entered into a Data Collection Proforma Sheet (Appendix 1) and were 

entered into Excel (MS Excel 2011). The Sheet had a visual map for marking and 

divided into indications for both genders. Other biographical details were also 

collected including date of birth, weight and height. 

4.5 STATISTICAL METHODS 

Statistical analysis was carried out using SPSS version 19.0 (IBM SPSS, US) software 

with Regression Modules installed.   

Descriptive analyses were reported as mean and standard deviation of continuous 

variables.  Linear  regression  analysis  was  performed  to  determine the association 

among USG determined Bone Age and Radiography determined Bone Age,  as well  

as  Chronological  age;  the  correlation  coefficient was  reported  together with  SEE  

(standard error of estimate), intercept and its standard error, coefficient of  independent  

variable  and  its  standard  error,  level  of significance.  

To assess the agreement of measured values, i.e. Age in months between two methods 

namely, (1) Bone Age Estimation by Ultrasonography based on Greulich Pyle Atlas 
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(2) Bone Age Estimation by Radiography based on Greulich Pyle Atlas, we used the 

methods described by Bland and Altman – the Bland-Altman Plot.  
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4.5.1 BLAND – ALTMAN PLOT 

Bland & Altman introduced the Bland-Altman plot1 to describe agreement between 

two quantitative measurements. There’s no p-value available to describe this 

agreement but rather a “quality control” concept. The difference of the paired two 

measurements is plotted against the mean of the two measurements and they 

recommend that 95% of the data points should lie within the ± 2sd of the mean 

difference. We subjected the Greulich-Pyle Atlas based age assessments done 

independently using Radiographs and by Ultrasonography to Altman and Band 

Statistical Analysis to assess the degree of agreement, correlation and concordance 

between the two methods and the results along with the Bland-Altman Chart are 

depicted below in the Results. 

The Bland-Altman chart is a scatterplot with the difference of the two measurements 

for each Patient on the vertical axis and the average of the two measurements on the 

horizontal axis. Three horizontal reference lines are superimposed on the scatterplot - 

one line at the average difference between the measurements, along with lines to mark 

the upper and lower control limits of plus and minus 1.96*sigma, respectively, where 

sigma is the standard deviation of the measurement differences. If the two methods are 

comparable, then differences should be small, with the mean of the differences close 

to 0, and show no systematic variation with the mean of the two measurements. 'Small' 

would be an amount that would be clinically insignificant for the factor being 

measured.2  

5 RESULTS 

5.1 DEMOGRAPHIC DATA 
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We assessed the Bone Age of 90 subjects aged from 1 month to 6 years of whom 53 

(58.9%) were boys and 37 (41.1%) were girls. The mean age in boys was about 3 years, 

3 months while in girls, 3 years 8 months with a standard deviation of 1 year 9 months 

(±1yr 9 m) and 1 year 4 months (±1yr 4 m) respectively. The Age was measured in 

months as per standardization principles. 

 

5.2 BLAND ALTMAN ANALYSIS 

Bland and Altman plot the mean difference between the X-ray and DXA assessments 

was -0.6 months with corresponding limits of agreement of 3.9 and -5.1 (2xSD). The 

mean difference did not significantly differ from zero, indicating lack of systematic 

differences. 

  

Figure 5-1 - Bland and Altman plot of the variation between Radiography and 

Ultrasonography assessments. The mean indicates the mean difference, with the 95% 

limits of agreement. 
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6 DISCUSSION 

 

7 CONCLUSION 

Based on the results and the methodology employed, we have concluded that:  

1)  

 

8 ABSTRACT 
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